Tools & Tips for the Upkeep & Revising of Your Site
Using AccVerify for Link Checking And ADA Compliance
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ADA Compliance & Link Checking

HiSoftware AccVerify offers you the ability to run reports that will help you identify several areas, including:

· ADA Compliance

· Broken Links

· Broken Anchors

How to Get the Software

Contact Evelyn Storay of e-Michigan (storaye)
How To Run A Report:

Complete Report (ADA & Link Verification)

1. Access the software

a. Start > Program Files > HiSoftware AccVerify > AccVerify Professional
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b. This is the AccVerify screen:
[image: image3.png][Load the HTML source from a fl on the Selected Fes page by pressing Load Fi.
This featur i only svaiable when local or FTP fes ae selected.





2. Create a Project for each report you will run regularly

a. File > Project > New
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b. Enter the Project Name and specify the type of project – Internet Based (Automated Crawler)
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c. Fill in the Project Settings – these can be changed each time the project is run
[image: image6.png]tomated Web Browse Propeties

Do

format: it /s hisoftwate.com/

Star il

format; indethiml
I¥' Bun sccessiity checks when runring verfication
@ Use defaul e types

€ Dl use the defined fle types

File Types.
Fie Selecon | Auheicaton| Bose Optos | Exchde Diccores| Biowser | Fiter |
T Start Automated Browse File Selection when project is opened
T The starting page contains an authentication form. Form Data:
T Associate File List
File List

ip o Cancel







d. Enter the URL for the Project
- If there is a start file, enter it (usually not in Michigan.gov)
- Check the Run accessibility checks box
- Check the Use default file types radio button
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To limit the report to a Button or Marketing URL that stays within Michigan.gov:

i. In the Domain field enter the same thing – the name of the site


ii. In the Start File field enter the URL for the page that the Button or the Marketing URL starts on

HAL Things to Do Button
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e. Click the File Selection tab and check the Start Automated Browse File Selection when project is opened check box.
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f. Click the Authentication tab and enter any authentication information that may be required (not needed if a Michigan.gov site)
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g. Click the Browse Options tab and check all the check boxes and set the number of levels to crawl. 
- The fewer the levels, the faster the report will complete, but the less of your site will be verified. 
- The greater the levels, the longer it will take, but the more of your site will be done. 
- To get your whole site, generally no more than 5 levels are needed for a very large site.
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h. Click the Exclude Directories tab and click Get Robots. The following will be entered.
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i. When you click Get Robots you will get the message below, click OK. 
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i. Click the Browser Emulation tab and select a browser to emulate, if desired. If none desired, select AccVerify.
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j. Select the Filter tab and enter your site and set the Filter Type to Include. This will tell AccVerify to only include web pages from your site and to not include pages from other sites.
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NOTE: You can include various permutations of your URL if desired. (See above)


k. Click Save.
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l. The project will start to run, for now, Cancel the project. We will start it later.
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m. Close the project – File > Project > Close
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n. The project will be saved in the left panel of the screen.
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3. You can change any of the Settings at any time
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4. Project Settings – These are the same settings you set up when you created the project.
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5. Accessibility Rules – you can change which rules are tested by checking and unchecking the boxes.
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6. Recorder Settings allow you to specify where the accessibility validation information will be kept. It will be maintained in a database. Each time the project is run, the database will be overwritten. The History database will allow you track progress over time.

a. General – this tab allows you to specify the location of the databases.

b. Advanced – this tab allows you to specify which elements to record in the database.

c. EARL is an acronym for Evaluation And Report Language. These meet W3C standards for the purpose of providing a framework for generic evaluation description formats that can be used in generic evaluation and report tools. These are XML-based records that can be used or modified any way you wish.


[image: image26.png][Project Accessibility Recorder Settings - eMichigan
General | Advanced | EARL Publisher |
Accessibily Recorder Setings

D% e Acca iy Resaide] I |5 Bt Dotobese

Accessiity Recordsr Database Location:
[C:\Program FlestHISC\Accierly FroFrojects\eMichigan'_sccdb

‘Accesshity Recorder Histoy Database Localor:
[C:\Program FlestHISC\Accierly FroFrojects\eMichigan'_sccdb

‘Bepott Publsh Locatior:
[C:Progiam FlestHISC\Accerly Fro\coReportsheMichigart.

ip ve Cancel





7. Report Settings

a. Report Mode
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b. Report Templates
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c. Report Detail
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i. Exclude Good Pages – Under the Report Detail Options select the second radio button – Show only Failures or Warnings
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ii. Include Only Failures
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1. Under Checkpoint Detail, Check the second radio button.
2. Uncheck the items you don’t want to see reported. Make sure to keep “Failed” items checked.


d. Custom Reports
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e. Advanced
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i. Site Quality Settings - Uncheck the boxes for reports you don’t need to see
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ii. Report Graph Settings
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iii. Customized Report Text
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iv. Report Folder Location
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f. AccRepair Settings allow you to choose whether you want to run the AccRepair Wizard after you test for accessibility. Web files from a web server cannot be repaired directly through the web server. Since Michigan.gov files are on a web server, this is not an option for us.
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8. Open a Project and Run a Report.

a. Open a project by first selecting it in the left panel.
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b. From the File menu select Project > Open Project – project name.
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c. The report will automatically open and be ready to start to run. Your input will be needed. You can change any of the parameters you wish at this point.
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d. In addition, you can specify a location to save the resulting report. Click on the Report Group tab.
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e. Click the Use Report Group check box and enter a Report Group Name. Click Start
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f. The report will start to run. It will first download and analyze files and then will run a verification.
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g. The resulting report will be displayed in the right panel of the screen. We will discuss reading the report shortly.
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How To Interpret The Report:

Complete Report (ADA & Link Verification)

1. Overall Summary
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2. Accessibility Reports

1. Summary
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2. Statistics Summary
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Images with null Alt attribute: 2491 using the Alt
attribute: 142
Image Counts by file extension: Forms without Input
80id=4520-6022- elements: 1

51151138ptid=452080nid=60228sid=1835id=51151138astid=1 Forms with Input
= Images not using
the Alt attribute: 2
Forms without any
use of

Tabindex: 153
Forms without any
use of

AccessKey: 16




 [image: image51.png]Frame Summary
Frames: 2

Frames without
Title Attribute: 2

IFrames: §
IFrames without
element content: 2

Table Summary Sorint 5
Tables: 1467 Script Summary

Tables with Summary attribute: 1 Serpt Elements:
Tables with Caption: 1 : ot
Tables with Summary and Caption: 1 ages using Scrip

Data Tables: 258 Elements: 156
Pages using Script

Elements without

Object Summary
NOSCRIPT: 152

Objects: 1
Objects withaut slement content: 0 Link Summar.

Applet Summary Links with the
Applets: 1 phrase "Click Here"

Applets without either the Alt attribute or element content: 1 In the link text: 13
Links to DOC files:

71
Links ta MP3 files: 0
Links to MPG files: 0
Links to PDF files

71

Links ta PPT files

66

Links to SWF files

0

Links to XLS files: 3






3. Passed Files
[image: image52.png]016077112+ 00 bl
01607, 7-112-101583-,
01807, 7:112-105723-,
0160771210886
/01607.7:112:10886_11
01607, 7:112-107432-
0180771121053~
01607, 7:112-111305-
01807 1121125
01807 711211275
01807 121128 0
01607, 7:112:1128-R
01807 121128 0
J0AE07 7-112-1130-F 0






a. Select a file
[image: image53.png]=4 PassedFiles - 134
B/
B0 /016077212 00
|0 /01607.7:112-101553

g /0160771210686




b. Read the Report – If desired
[image: image54.png]AccVerify Report

Verified File Name: http:

00.html
Date and Time: 2/2/2006 1:49:18 PM
Passed Automated Verification

‘www michigan.gov/e-michigan/0,1607,7-112--105723-~

The level of detail setting for the report is to show all detail

[checkpoints [ Passed

[508 Standards, Section 1194.22 [Yes [N [Other

/A, 508 Standards, Section 1194.22,(a) A text equivalent for every
non-text element shall be provided (e.g., via “alt”, "longdesc”, or in
element content).
 Rule: 1.1.1 - All ING elements are required to contain sither the alt or
the longdesc attribute.
© Warning - IMG Element found at Linet 99, Calumn: & contains
the ‘alt”attribute with an empty value, Piease verify that this
image is only used for spacing or design and has no meaning.
© Warning - IMG Element found at Line: 121, Column: 17 contains,
the ‘alt”attribute with an empty value, Pleass verify that this
image is only used for spacing or design and has no meaning.
© Warning - IMG Element found at Line: 141, Column: 32 contains,
the ‘alt”attribute with an empty value, Pleass verify that this
image is only used for spacing or design and has no meaning.
Warning - IMG Element found at Linet 144, Column: & cantains
the 'alt”attribute with an empty value, Pleass verify that this
image is only used for spacing or design and has no meaning.
o Rule: 1.1.2 - All INPUT elements are required to contain the alt

Yes





4. Failed Files
[image: image55.png]/0.1607.7-112:10686,1
01607.7:112:15476.4
/01607, 7-1121616347:
01607.7:112:25087-70
0160771123354 33
01807 7112473120
0160771247341
01607.7:112-47634-.
01607.7:112-70384-.
01607.7:112-765%5-.
01B07.7:112-83010-1
hitg:/audgen michigan.
hitg://blogs law hervard.
hitg:/connect ichigan.
hitg:/connect ichigan.
hitg:/connect ichigan.
g/ /michigan.govimsh
hig://senate.michigan.g
http:/ 7w bradsoft.com







i. Select a file from your site
[image: image56.png]B4 FaiedFiles - 31
[ /0.16077-11210886_11
B0 /01607 71121547647
B0 /01607 7:11216169.4

(£ /0.1607,7-112.33854_33




ii. Read the Report
[image: image57.png]AccVerify Report

Verified File Name: http: //www michigan.gov/e-michigan/0,1607,7-112-25007-
70386--F,00.htrl

Date and Time: 2/2/2006 1:48:51 PM
Failed Automated Verification

The level of detail setting for the report is to show all detail

[Checkpoints | Passed
(508 Standards, Section 1194.22 [Yes|No [Other
/A_508 Standards, Sertion 1194.22. () A text equivalent for every No

non-text element shall be provided (e.g., via “alt”, "longdesc”, or in
element content).
 Rule: 1.1.1 - All ING elements are required to contain sither the alt or
the longdesc attribute.
© Warning - IMG Element found at Linet 99, Calumn: & contains
the ‘alt”attribute with an empty value, Piease verify that this
image is only used for spacing or design and has no meaning.
© Warning - IMG Element found at Line: 104, Column: 51 contains,
the ‘alt”attribute with an empty value, Please verify that this
image is only used for spacing or design and has no meaning.
© Warning - ING Element found a Line: 104, Column: 169
contains the 'alt’ attribute with an empty value. Please verify
that this image is anly used for spacing or desin and has no
meaning
© Warning - IMG Element found a Line: 104, Column: 243
contains the 'alt’ attribute with an empty value. Please verify
that this image is anly used for spacing or desin and has no
meaning



[image: image58.png]°

Warning - IMG Element found at Line: 113, Column: 35 contains
the 'alt”attribute with an empty value, Please verify that this
image is only used for spacing or design and has no meaning.
Warning - IMG Element found at Line: 124, Column: 35 cantains,
the ‘alt”attribute with an empty value, Please verify that this
image is only used for spacing or design and has no meaning.

°

o Failure - MG Element at Line: 177, Column: 21
© Failure - MG Element at Line: 178, Column: 21
© Failure - MG Element at Line: 439, Column: 21
© Failure - MG Element at Line: 451, Column: 21
© Failure - MG Element at Line: 502, Column: 21
© Failure - MG Element at Line: 504, Column: 21
© Warning - IMG Element found at Ling: 1112, Column: 41

contains the 'alt’ attribute with an empty valus. Please verify
that this image is anly used for spacing or desin and has no
meaning
© Warning - IMG Element found a Line: 1113, Column: 17
contains the 'alt’ attribute with an empty valus. Please verify
that this image is anly used for spacing or desin and has no
meaning
© Warning - IMG Element found a Line: 1132, Column: 11
contains the 'alt’ attribute with an empty valus. Please verify
that this image is anly used for spacing or desin and has no
meaning
Rule: 1.1.2 - All INPUT elements are required to cantain the alt
attributs or use a LABEL,
© N invalid INPLT slements found in document,
Rule: 1.1.3 - All OBJECT elements are required to contain element
content,
© Ho OBJECT elements found in document body.
Rule: 1.1.4 - All APPLET elements are required to contain both
element content and the alt attribute.
© o APPLET elements found in document body.
Rule: 1.1,6 - All IFRAME elements are required to contain element
content,
© No IFRAME elements found in docurment bady.




[image: image59.png]Rule: 1.1.7 - All Anchor elements found within MAP elements are.
required to contsin the alt sttribute.

© o MAP elements found in document body.
Rule: 1.1.8 - All AREA elements are required ta contain the alt
attribute.

© Ho AREA elements found in document body.
Rule: 1.1.9 - When EMBED Elements are used, the NOEMBED element
is required in the document.

© No EMBED elements found in document body.








Included in the error report is a Source Listing so you can locate the Warnings and Failures to see if they need corrections and where and how to correct them.
[image: image60.png]Source Listing

<1-- Vignette V6 Tue Jan 24 07:57:02 2006

<i-- e-NMichigan Portal - Process #2 ——>
<!IDOCTYPE HTHL PUBLIC "~//U3C//DTD HTHL 4.01 Transitional
<htnl>
<head>

<META htep-equiv="Content-Type" content="text/html; chars

<title>COLOR: Where can I find a Web Safe Color Picker?
<meta neme='DESCRIPTION' content='COLOR: Where can I £i
<meta neme='KEYVORDS' content='No Keywords'>
<meta htep-equive'last-Nodified' content='Ued, 18 Jun
<meta neme='catlvll' content='25097'>

<base target='_top'>

<i-- Global CS§ —->





[image: image61.png]175:
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src= "/ inages/0_S9_7.gif" wiac

<TD><FONT face="Verdana, Helvetica, Sans-serif”







5. Site Quality Reports

a. File Type – lists the various types of files that are not HTML or images and the links to those files.
[image: image62.png]HiSoftware AccVerify Site Quality Report
Date and Time: 2/2/2006 1:49:52 PM
Back to the Accessibility Statistics Summary Report

Links for File Type: DOC

File Link

http: /connect.michigan .gov/portal/binary/com epicentric.contentmanagement
http: /connect.michigan .gov/portal/binary/com epicentric.contentmanagement
http: /connect.michigan .gov/portal/binary/com epicentric.contentmanagement
http: /connect.michigan .gov/portal/binary/com epicentric.contentmanagement
http: /connect.michigan .gov/portal/binary/com epicentric.contentmanagement
http: /connect.michigan .gov/portal/binary/com epicentric.contentmanagement
http: /connect.michigan .gov/portal/binary/com epicentric.contentmanagement

http: /connect.michigan .gov/portal/binary/com epicentric.contentmanagement




.
.
.
[image: image63.png]Links for File Typ
File Link

hittp:/feourts michinan.aov/scan/resources/standards/cf_casetypecodes.pdf

hittp:/fcourts michinan.aov/sean/resources/standards/cf_schd.odf

http://senate.michigan.aov/MainP ageFiles/Michigan®:20Legislative%20Handb
httn:ffwww insidepolitics ora/eanvt0dus odf

hittp:/fwww michiqan.qov/documents/d-2003newsletter 73043 7.pdf
http:/fwww michiqan.qov/documents/AWOL Update 50295 7.ndf

http:/fwww.michigan.qov/documents/Dec2004News 110037 7.pdf

http: /fwww.michigan.gov/documents/e-michigan_ewebEditera_Upgrade 200

http:/fwww.michigan.qov/documents/formshelp 67348 7.ndf

http:/fwww michigan.qov/documents/gethere 14067 7.PDF




.
.
.
.
[image: image64.png]Links for File Type: PPT
File Link

hittp:/fwww.michiqan.qov/documents/AccessibleWebsites and textonly 117

http:/fwww.michigan.qov/documents/CMA_CDA Cateqories 123986 7.ppt

hittp:/fwww.michigan.qov/documents/CMA_Warkshap-links 88431 7.ppt

http:/fwww.michigan.qov/documents/Dect CMA AccRepair 143717 7.ppt

http:/fwww michiqan.qov/documents/ePosteard 96084 7.pot

http:/fwww.michigan.qov/documents/Intranet for Agencies? 96065 7.ppt

http:/fwww michigan.qov/documents/licensing 96085 7.pot

http:/fwww.michigan.qov/documents/Links Terminology 130758 7.ppt

httn:/fwww.michigan.gov/documents/marketing urls 110032 7.

http:/fwww michiqan.qov/documents/MichiganPortalll 85744 7.t

http:/fwww michiqan.qov/documents/MigovStyleSheets 110033 7.pot

hittp:/fwww michiqan.qov/documents/MitlewsWire 85610 7.t

http:/fwww.michigan.qov/documents/onlineservices 117472 7.t

http:/fwww.michigan gov/documents/PDFauidelines 92409 7.

httn://www michigan.gov/documents/Portal 11 104522 7.ppt




.
.
.
.
[image: image65.png]Links for File Type: XLS
k

hittp:/fwww michiqan.qov/documents/badFileNames 125910 7.xls

File

http:/fwww.michigan.qov/documents/CatWE 62091 7.ls







b. Link Phrase – shows you a list of files with the phrase “Click Here”. Please verify that this phrase is not used alone as a link in your site, except in a theme page where you have no control. 
[image: image66.png]HiSoftware AccVerify Site Quality Report
Date and Time: 2/2/2006 1:49:52 PM
Back to the Accessibility Staf s Summary Report

Link Phrase Report
Files with one of the following phrases in the text of a link: "Click Here"

File Link

Count
httn:/audgen michigan.aov 1
httn: {fwww.michigan gov/e-mithigan/0,1607.7-112-10666---,00.html 2
http:/fwww.michigan.gov/e-michigan/0,1607.7-112-1142-2088--,00 html 2
http: {fwww.michigan gov/e-michigan/0,1607.7-112-15476_11091---,00 html 3
httn: {fwww.michigan gov/e-mithigan/0,1607.7-112-15476 11091 16156-—- 1
00-himl

httn: {fwww.michigan gov/e-mithigan/0,1607.7-112-15476_16145 29162--- 1
00-himl

http:/fwww.michiqan.qov/e-michigan/0,1607,7-112-3355¢ 33571 33572--- 1
00-himl

http: {fwww.michiganfitness ar 2





Note that you have no control over the Click Here phrase in the Theme template.
[image: image67.png]it of iz hat re

Poftered and those that are
Gaing davelaped for th futur,
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Note that the Click Here phrase was found as part of a larger link phrase and is a valid link phrase when used as a complete sentence.
[image: image68.png]you link to one of these sites, hichigan canpal.controltaey use of
cookies and this privacy policy will ot apph. Click hete tolview the
Michigan Linking Policy.

If you choose to do so, you can configure your browser to notify you
when a new cookie is received. You can also prevent your browser from

accepting any new(CaaKIES, Ve and delete existing cookies o disable
cookies altagether| Click here td link to directions on how to do this






This is an example of poor use of the phrase Click Here in a link. This needs to be corrected.
[image: image69.png]Governar's Lahor Day Bridge
 Please|click here t register.







c. Verify Data Table – shows a list of all pages that contain data tables. This will be all the pages in your site, since Michigan.gov uses tables to format all pages. The usefulness of this feature is questionable.
[image: image70.png]HiSoftware AccVerify Site Quality Report
Date and Time: 2/2/2006 1:49:52 PM

Verify Data Tables Report
Files with one or more data tables.

File Link

Count
http://blogs law harvard eduftech/rss 4
httn:/connect.michigan.aov/portal/site/dmb, 2
http:/connect.michigan aov/portal/site/intranet; 3
httn://mdotwas1 mdot state mi.us/oublic/LaneClosure, 2
httn:/michigan.gov/mach 1
http://michigan gov/mshda 4
httn:/ranchero.com/netnewsuwire, 1
http:/senate.michigan.aov, 1
hittp:/fwww.cnet.com/4520-6022-5115113 html 6
http: {fwww.courts michigan.aov 7
http:/fwww.house mi 1
http:/fwww ledislature.mi.qov/(ddSifr15 1iaeuSsSitsz0es)/mileq.aspx? 4

Dpage=home
httn: ffwww mackinacparks com, 1

httn: {fwww mfia.state.mi.us/awal, 1



.
.
.
[image: image71.png]http:/fwww.michigan.qov/e-michigan,
httn: ffwww.michigan gov/e-michigan/0,1607.7-112-—00.html
http: {fwww.michigan gov/e-michigan/0,1607.7-112--101593--,00 html
05723--,00 hitml
httn: {fwww.michigan gov/e-mithigan/0,1607.7-112-10666---,00.html

http: {fwww.michigan gov/e-michigan/0,1607.7-112-10666_1110:

http:/fwww michiqan.qov/e-michigan/0,1607,7-112-

00.html
00.html
07492--,00 hitml
10532--,00.html
11305--,00.html
httn:{fwww.michigan.gov/e-michigan/0,1607.7-112-1127 61,00 hitml

http: ffwww.michigan gov/e-michigan/0,1607.7-112-1128---F,00 html

http: ffwww.michigan gov/e-michigan/0,1607.7-112-1129---F,00 html

http: {fwww.michigan gov/e-michigan/0,1607.7-112-1130--F,00 html

htp: {fwww.michigan gov/e-michigan/0,1607.7-112-1134--F,00 html

http: {fwww.michigan gov/e-michigan/0,1607.7-112--117569--,00 html
18917--,00.html
29701--,00 hitml
30685--,00 html

http: {fwww.michigan gov/e-michigan/0,1607.7-112-10666_1111:
httn:ffwww.michigan gov/e-michigan/0,1607.7-112-

httn:ffwww.michigan gov/e-michigan/0,1607.7-112-

httn:ffwww.michigan gov/e-michigan/0,1607.7-112-

httn:ffwww.michigan gov/e-michigan/0,1607.7-112-
httn:ffwww.michigan gov/e-michigan/0,1607.7-112-

http:/fwww michigan.qov/e-michigan/0,1607,7-112--

O T T T T






d. Link Error – shows all the link errors found while validating your site. This will include any 404 – not found errors as well as errors such as time-out, access not allowed, name not resolved, etc. You can then isolate the page where the error is located and correct the errors.
[image: image72.png]HiSoftware AccVerify Site Quality Report
Date and Time: 2/2/2006 1:49:52 PM

Back to the Accessibility Statistics Summary Report

Link Errors Report
Links to files that were not verified/accessed due to an error.
jame Not Resolved. errors when checking

http: /fwww.connect.michigan.ov/dch

httn: {fwww.connect. michigan.aov/de:

http: {fwww.connect.michigan.ov/dnr







e. Max File Size Exception – shows you the files that were too large to validate. In the System Settings for AccVerify, you can change the Maximum File Size. The default is 100K.
[image: image73.png]HiSoftware AccVerify Site Quality Report

Date and Time: 2/2/2006 1:49:52 PM
Back to the Acces: y Statistics Summary Report

Maximunm File Size Exception Report

Links to files that were not verified due to being larger than the maximum allowed file size.
File Link

httn: ffconnect. michigan gov/portal/site/dle

http:/fwwwstate.mi.us/mdoc/MostWanted/MostWanted.asp
It {fww.w3.0r/ TRAWAL-WEBCONTENT;







f. Repetitive Anchor Text – shows pages that have links that say the same thing but go to different URLs. The URLs may actually go to the same page, so you will have to check that. It is so that you can check for possible confusion, especially for visually impaired readers.
[image: image74.png]HiSoftware AccVerify Site Quality Report
2/2/2006 1:49:52 PM

Date and Tim

Repetitive Anchor Text Report
Files with one or more repeating anchor texts pointing to different resources

File Link Count
http://blogs law harvard eduftech/rss 16

The anchor text: "here" is repeated 10 times.
The anchor text: "Mare” is repeated 6 times
httn:/michigan.gov/mach 4

The anchor text: "Mare” is repeated 2 times




.
.
.
[image: image75.png]http://www michigan.qov/e-michigan,

The anchor text: “Sits Map" is repeated 1 time

The anchor text: "Contact Us" is repeated 1 time.

httn: ffwww.michigan gov/e-michigan/0,1607.7-112-—00.html

The anchor text: “Sits Map" is repeated 1 time

The anchor text: "Contact Us" is repeated 1 time.

http: {fwww.michigan gov/e-michigan/0,1607.7-112--101593--,00 html
The anchor text: "Contact Us" is repeated 1 time.

http:/fwww michiqan.qov/e-michigan/0,1607,7-112--105723--,00 html

The anchor text: "Contact Us" is repeated 1 time.

httn: {fwww.michigan gov/e-mithigan/0,1607.7-112-10666---,00.html

The anchor text: "Click here for:" is repeated 1 time

The anchor text: "Contact Us" is repeated 1 time.

http: {fwww.michigan gov/e-michigan/0,1607.7-112-10666_11107---,00 html

The anchor text: "Contact Us” is repeated 1 time






g. NOSCRIPT Missing – shows pages that have a SCRIPT element but do not include a NOSCRIPT element. NOSCRIPT elements are necessary whenever a SCRIPT is being used for ADA compliance.
[image: image76.png]Missing NOSCRIPT Element Report
Links to files that use the SCRIPT Element and are missing the NOSCRIPT Element.,

File Link

http://blogs law harvard eduftech/rss
http:/connect.michigan aov/portal/site/intranet;
httn://mdotwas1 mdot state mi.us/oublic/LaneClosure,
httn://metrocommute com/detroitpopup.html
httn:/michigan.gov/mach

http://michigan gov/mshda
httn:/ranchero.com/netnewsuwire,
hittp:/fwww.cnet.com/4520-6022-5115113 html

http: {fwww.courts michigan.aov

http:/fwww.house mi

hittp:/fwww ledislature.mi.qov/(ddSifor15 1iaeuSSSsitsz0es)/mile.aspx?nage=haome

httn: ffwww mackinacparks com,
httn: {fwww mfia.state.mi.us/awal,
http: ffwww.michigan gov/a

htp: /fwww.michigan gov/e-michigan,

httn: ffwww.michigan gov/e-michigan/0,1607.7-112-—00.html
http: {fwww.michigan gov/e-michigan/0,1607.7-112--101593--,00 html

http:/fwww michiqan.qov/e-michigan/0,1607,7-112--105723--,00 html

http:#/www michigan.qov/e-michidan/0,1607,7-112-10666---,00 html







h. Title Element Errors – shows pages that either do not have Title text or multiple pages that have the same title text. Please note that some pages are the same content ID with different category IDs. This does not need correcting.
[image: image77.png]TITLE Element Errors Report
Links to files that do not use the TITLE element or the TITLE element has no text.

hitp:/fmi-mallmichiaan.aoy

Links to fles that have a duplicated title
The page title "ADA Issues" is repeated in 2 files.
hitp:f/www michigan.cov/e-michigan/0 1607.7-112-1547d 74778 oo ntmi
hitp:ffwww michigan. qov/e-michinan/0,1607,7-112 {74776 | 00 html

‘The page title "Agency Site Contact List" s repeated in 2 files.
http:f/www michigan.cov/e-michigan/0,1607.7-112-15476-47341-- 00 html.
hittp:f/www michigan.oov/e-michigan/0,1607,7-112--47341-,00.htmi

The page title “Assets for CMA Training" is repeated in 2 files.

hittp:f/www michigan.oov/e-michian/0,1607.,7-112--105723--,00.html

The page title "ASSETS: What is the best way to name your assst files for successful
Uploading and use by your customers?" is repeated in 2 files

i vie-michi 7.7-112-25097-5





Send the Report to Someone Else

If you want to send all or part of the report to someone else, you can use the Distribute button at the bottom of the screen. This will allow you to zip the report and e-mail it to the desired recipients. 

If you would like to send sections of the report to different recipients, you need to initially send the report to yourself so you can break the report apart and send individual files to the desired recipients.


1. Click Distribute
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2. Select the REPORT you wish to send to someone else. Make sure you select a Report and not a Project. Click Next.
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3. AccVerify is going to Zip the files required for the report. Select a folder and enter a filename for the location of the Zip file using the button at the end of the field. Check the Send mail message check box to enter e-mail information.
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4. Enter the e-mail address of the recipient (send it to yourself the first time at least so you can see what it looks like). Enter the Subject and Message of the e-mail message and click Finish.
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5. It will Zip and Save the file and then open a mail message, complete the mail message and send the message.
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6. To open, unzip and read the file go to your mailbox and locate the message. Open the attachment and start the Unzip process.
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7. Extract all the files – set a location for the file to go to.
Select all the files and click Extract.
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8. Specify the Folder where you want the extracted files to go.
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9. Open the folder where the files were unpacked.
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10. Locate the file that ends in toc.htm and open it.
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11. This (above) is the Table of Contents file and will have links to all the other files. These other files are in subfolders within the folder where you unpacked the zip file. When you click on a link, the report will open in a new window. Each report will open in the same new window.
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12. If you wish to send different reports to different people, open the report you wish to send to a different person and copy the Address to the file.
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13. Send an e-mail message to that person and attach a file to the e-mail message, pasting the path you just copied.
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14. If you wish to send the entire report to another person, include them in the distribution list when you are sending the Zip file to yourself and send them instructions on how to unzip and read the report.

Eliminate Click Here For: on Theme Page Layouts/Templates

As a Site Administrator you can now change the text on theme pages for the “Click here for:” section. If you use Theme page layouts/templates, this will greatly reduce the number of errors you receive in the Link Phrase section of the Site Quality report.

Make the change in the Component Modifier of the Theme Page Layout:

1. Edit the Left Navigation Category for the Theme page
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2. Modify the Page Layout
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3. Select the second component, Theme Page Cat List and click Go
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4. In the field set aside for More enter the text you want to use instead of “Click here for:” Whatever you type in this field will be substituted in all instances on that page. Some suggestions:

a. Find out about: [image: image1.png]



b. Learn about:

c. All about:

d. View:

e. Use a <Space> for nothing


5. You must manually clear the cache in order for it to go live.
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Link Verification Only

1. Link Validation Utility can be accessed from two locations:

a. From within AccVerify Tools > Link Validation Utility
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b. From Start> Program Files > HiSoftware Link Validation Utility > Link Validation Utility
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c. You will get a notice about the software being in Evaluation Mode. Close the window.
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d. HiSoftware Link Validation Utility
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e. Settings
f. Before you start a report, you need to set up the default settings. Click Settings > Options.
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g. Under Crawler Scope choose URL Path Only
Under Returned URL Scope choose All Links
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h. Click the Exclusions tab and choose the Robot.txt radio button.
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i. Click the Output tab and select Group by Status. [image: image108.png]Options
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j. Click on the Filter tab and select “Only Show Failed Links in the Report” from the drop-down menu. Click OK at the bottom of the screen.
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k. Enter the Starting URL, Number of Levels and click Start
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NOTE: To limit the report to a Button or Marketing URL whose destination is within Michigan.gov, in the Starting URL field enter the URL for the Button or Marketing URL within Michigan.gov.

HAL Exhibits and Events Button
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l. Results start coming in right away and keep coming in while the report is running.
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m. When the report is done, you will be given a summary and the option of generating a Site Map and/or HTML Report.
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Saving and Reading the Report

1. Site Map Report
C:\Program Files\Common Files\HiSoftware\Link Validation Utility\Reports\SiteMap.htm
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2. Save the report as a Project - 
File > Save As Project
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3. Give the Project a name
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4. Results in the Link Validation Utility
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Note that the page in which the link is located is not available.
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5. When the Scan is complete you will be able to get an HTML Report
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6. The HTML Report shows the errors with the source page.
With the settings for the report to be Grouped by Type, we can easily distinguish our various types of errors.
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7. 12007 Errors: Internet Name Not Resolved
With these links, the URL is usually typed incorrectly.
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8. 12045 Errors: Invalid Certification Authority
These errors are caused when the site to be reached was a secured site and the Authentication Certificate was invalid.
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9. 401 Errors: Unauthorized
These errors refer to links to sites which require a log-on or other form of authorization.
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10. 404 Errors: Not Found
These errors are the ones that contain your broken links and broken images. Each broken link and broken image will be listed separately along with a list of each page where the link is located. You will be able to click on a link to the page to locate where the link is located so that you can find it and correct it. 

Sometimes the link is typed wrong, sometimes the link is to a site that has moved, and sometimes the link is to an asset that has been deleted. Make sure that you correct these links.
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11. Failed Errors: Bookmark Not Found
This error is reported when you have a link to a bookmark and the bookmark is unable to be located. Please correct these errors.
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12. Interrupted Links
These are links that were not reached due to a time-out. The tool ran into the time-out limit before the link was resolved. You should manually check these links to verify their accuracy.
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13. N/A Links
These are links that cannot be verified by the system – usually mailto links.
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14. No Server Specified:
These are links in which no server was specified in the URL. This could be because it was meant to be a relative link and the http:// was left in inadvertently, or a mistake was made when entering the link URL. These need to be corrected.
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15. OK Links
This is a list of links whose status came back OK. There is nothing wrong with these links. Nothing needs to be done with these links.
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16. Other Error Codes
i. 12002 - time out - the system didn't have time to check the error before the network timed out

ii. 12029 - is a firewall issue - the link it is trying to verify is behind a firewall that it cannot cross

iii. 12031 - it lost the connection to the server for some reason - treat it as a timeout

iv. 405 - relates to a form - check to make sure the form is working

v. 500 - Internal server error - if it is one of your pages - there is a problem with the page. If it is a link to another site - the link is broken.

vi. Error - is undefined - check them out.
Sharing the Report with Others

You can save the resulting HTML report as a file on your hard drive or local drive and share it with other people.

Simply go to File > Save As
[image: image137.emf]


And then select a destination, give the file a name and click Save.
[image: image138.emf]


You will then be able to e-mail the html file to anyone you wish to share it with.

Evaluation: http://www.michigan.gov/trainingeval
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